
Understanding Curves: 
Our series on curves continues
with a look at color correction

Plus: Digital Photography Techniques, Photoshop® CS4 Tutorials, and More!

Symmetry
From Photo to Photoshop!
By Gareth Glynn Ash

The Waterfalls, Rainforests, and Wildlife
of Port Douglas - by David Martin

AUSTRALIA!

Y O U R  G U I D E  T O  T H E  W O R L D  O F  D I G I T A L  P H O T O G R A P H Y

PhotographyBB
online

ISSUE #18 - July 2009

  
 

PHOTOGRAPHY TIPS 
AND TECHNIQUES

    
SPOTLIGHT ON 

PHOTOGRAPHER
IMPROVING YOUR

DIGITAL WORKFLOW 
IMAGE EDITING 

TIPS & TUTORIALS 

Pentax K-7
Boasting new DSLR technology!
By Dave Seeram



Pa
ge

 2

PhotographyBB Online Magazine

From The Editor’s Desk

PhotographyBB Online Magazine Issue Eighteen: Composition Baby!

Dave Seeram is the Editor in Chief for PhotographyBB Online Magazine. As 
the administrator of the PhotographyBB Website and Forums, Dave is also 
an experienced author of several Photoshop® Actions and Tutorials which 
can be found on http://www.PhotographyBB.com

Welcome to our 18th edition of the PhotographyBB Online Magazine! Photography wise, 
I had an extremely rewarding month. I was fortunate to sit down with Pentax to play 
with a production model of the new K-7 and learn more about its capabilities, which I’ll 

be sharing with you in a special article this month. I also spent some time in Orlando where I was 
able to visit small pieces of different countries of the world, at Disney’s Epcot. Additionally, I was 
lucky enough to see the launch of the Space Shuttle, but was slightly disappointed that I was not 
carrying my zoom lens on this particular trip; but hey, seeing the Shuttle launch with your own 
eyes - who could be disappointed about that! I came home with half a day’s rest before heading 
out on the Scott Kelby Worldwide Photowalk, lead by a wonderful photographer, David duChemin 
of Vancouver. So as I said, photography-wise, it was a fantastic month!

All of that excitement did leave us pressed for time with the release of this issue, hence the 
reason we are releasing so close to the end of the month. The name of the game this month is 
composition! Gareth Glynn Ash has put together an awesome article on how to think in terms 
of symmetry, along with a Photoshop tutorial on creating symmetrical works of art. You’ll be 
surprised at all the symmetry in your life! Additionally, Jason Anderson gives us a unique look at 
the Rule of Thirds, and how it even relates to works of art throughout history. Hey, if it worked for 
Van Gogh, it’s probably gonna work for you too! For digital compositions, Jennifer Farley is back 
with a Photoshop tutorial on creating composite images, showing us how to add fireworks to any 
night photo. 

We also have two additional guest contributors this month. David Martin who whisks us off 
on a photographic journey to Port Douglas, Australia, where we get a great look at the wildlife, 
rainforest, waterfalls, and beaches. We also have Chris Walters, a long time forum member, joining 
us in our Spotlight this month, with an extremely interesting interview that I urge you all to read. 
Chris has had a lot of photography experience, and has some valuable insights to share with us.

John Ayres shares with us his views on photographer’s rights in today’s America, and what 
it may mean for the future of the rights of photographers. It’s always a hot debate, and Jon’s got 
some interesting points to ponder. And speaking of things to ponder, Ken Fagan brings us an 
editorial on whether or not cell phone cameras are replacing the point and shooters.

John Ogden kicks off a brand new series on Portraiture Photography 101 where we’ll look at 
lighting, portrait techniques, and much more. And last but certainly not least, Colin Bell continues 
our new FAQ series answering your questions. Be sure to send in any questions you have, and they 
will be addressed in future issues!

Thanks to all of the contributing authors for all of your enthusiasm and hard work. Also, a 
special thanks to the readers of our magazine, who make all this hard work both fun and rewarding. 
Enjoy the 18th edition of the PhotographyBB Online Magazine!

Dave Seeram
Editor and Publisher
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Over the past few years I have noticed 
something, something huge…Call me old 
fashioned but are cell phones becoming the 

new point and shoot or compact camera? Will they 
or have they already caused a major dent in the 
small camera market of today? 

Being a photographer I have started to notice 
that people, to an ever increasing degree, don’t 
bring their cameras out anymore. Why is this? One 
simple answer may be the cell phone; every few 
months a phone with an apparently better-than-
the-last-one type of camera comes on the market.  
So why bother with an 8mp camera when you can 
have an 8mp camera built into your phone? I have 
no problem with phone cameras but they really 
do nothing for your skills as a photographer. Yes, 
there can be some great results to be got from your 
phone but do you really want to be looking at a 

bunch of distorted, pixilated images of your soon 
to be all grown up kids? It annoys me when people 
fail to notice the differences between a photo from 
a P&S and a grubby cell phone. 

If I see this occurring on a small scale, imagine 
what it is doing to the compact camera market in 
general. Unless the likes of Canon, Nikon and Pentax 
can come up with a camera that has a built-in phone, 
the only way seems to be down. And although 
there has been a surge in compact cameras on the 
market, there also has been a major surge in camera 
phones. I think it’s safe to say that every phone has a 
camera now; that sounds like an old fashioned, out 
dated thing to say but it must be a real problem for 
the ‘proper’ camera manufactures that I mentioned 
earlier. I would like to know how many people have 
put away their little cameras in exchange for the 
camera on their cell phones, and how many have 
decided against buying a new compact camera 
because they got one on their new phone?

I never use the camera on my phone, frankly its 
rubbish, but I would also rather use a camera which I 
spent my hard earned money on to specifically take 
photographs and not some gadget that I can also 
make phone calls and look up dirt on the internet 
with. I can understand using your phone camera 
if you were caught without your compact but to 
blatantly abandon your compact for a diminutive 
phone camera is ludicrous. I am not sure if it is 
laziness or ignorance that has people choosing their 
phone over their camera but either way, something 
has to be done about it.

I must stress that I haven’t got an issue with 
people using their camera phones to photograph 
whatever they like, but I do have a problem with the 
way people can just pass off the camera phone and 
the point and shoot as being the same thing. They 
are not, and to be truthful I hope they never will be. 
Something more distressing is the individuals who 
can’t see the benefits of an SLR over a point and 
shoot, but I’m not going to open that can of worms 
just yet!

WILL CELL PHONE CAMERAS BE THE DEATH OF P&S? - By Kenneth Fagan

Confessions of a Photographer...
EDITORIAL THOUGHTS, FACTS, AND OPINIONS FROM THE TEAM AT PHOTOGRAPHYBB.
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THE NEW

K-7
This month, we had an opportunity to sit down with Pentax to chat about their latest release, the K-7 
Digital SLR powerhouse. While Pentax appeared to be quiet for the first half of the year, they have broken 
the silence with the new K-7 DSLR. With a redesigned, smaller weather resistant body and tonnes of 
new features such as in-camera HDR (high dynamic range) imaging, image stabilization, a built-in level 
indicator, and high-definition video, this DLSR really packs a heavy punch!  

The first and most noticable feature of the K-7 is its 
redesigned magnesium alloy body. The new design makes 
the K-7 one of the smallest DLSRs in its class, along with 
being weather, dust, and cold resistant. The body feels 
smaller, with a decent weight and a professional quality 
construction. With a street price of $1300 USD (body only), 
you truly get pro-level build quality with the K-7.

Sensor Technology:
The K-7 sports a 14.6 megapixel CMOS sensor with 

some enhancements to boot. This new sensor has advanced 

in the reduction of shadow noise, especially in low-light 
conditions. The standard ISO goes up to 3200, expandable 
to 6400. Pentax has also incorporated improved image 
stabilization technology built into the camera, making it 
compatible to all Pentax and Pentax-ready lenses. 

Image Recomposition:
One of the coolest things are the composition tools 

in this camera. Not only does the K-7 have a built in level 
indicator similar to those found only on high-end Nikons, 
but there is also a unique image recomposition tool also. 
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Since the K-7 uses a sensor-shift image stabilization system, 
you can actually recompose your image by moving the 
sensor, rather than the camera. Let’s say you have the K-7 
mounted on a tripod or macro-rail, but you need to shift 
your framing either up, down, left, or right. Using the live-
view mode, you can adjust your composition by moving 
the imaging sensor, without ever moving the tripod or 
camera mount!

Additionally, the K-7 boasts other compositional 
features usually only found in high-end DSLRs; the ability 
to auto-correct lens distortion and lateral chromatic 
aberration on any digital lens!

In-Camera HDR:
In a first for DSLR technology, Pentax has stepped up 

with an in-camera HDR (high dynamic range) imaging 

feature. Rather than doing all of the HDR processing at 
your computer, the K-7 will snap 3 photos at different 
exposure levels (over-exposed, regular exposure, and 
under-exposed), and combine them into a single JPEG. 
Of course, many HDR enthusiasts may still prefer the 
additional control of doing their work on the desktop, but 
newcomers to HDR imaging will certainly gain from having 
this feature built-in. Kudos to Pentax for including what’s 
sure to become a popular DSLR technology.

HD Video:
With the high quality lenses available to DSLR cameras, 

many manufacturers are now including HD video recording 
capabilities. The K-7 offers 1280x720 (720p) high definition 
video recording, but does it at a blazing 30 frames per 
second as opposed to many competitor’s models who 
clock out at 24 frames per second max.
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Audio is captured via the built in mono microphone, 
with an additional stereo microphone input if you prefer 
to have an external mic system.  Video files are recorded in 
the more common Motion JPEG format as AVI files which 
are great for those of you with DivX capable DVD players. 

While recording a video, the K-7’s also allows you to use 
the autofocus system by pressing an AF button on the back 
of the camera. That’s especially cool since some competitor 
models will lock the focus while recording video. The K-7 
also offers aperture control and shake reduction while 
recording too. That’s cool stuff, but be sure to keep some 
extra memory cards handy for those HD videos!

New LCD and Live View:
The Pentax K-7 has a brand new, 921,000 dot, 3-inch LCD 

display on the rear of the camera which can be especially 
useful when viewing recorded HD movies and previewing 
photos. This is a great feature for those photographers 
wearing glasses, who can now make use of the more 
comfortable “live view” shooting mode via the LCD. 

The K-7’s 3-inch LCD display gives you is the ability 
to view  things like: Contrast Autofocus, optional face 
detection, histogram display, grid, and bright/dark areas all 
while shooting in live view.

Prime II Processor:
Under the hood of the K-7 is Pentax’s all new Prime II 

image processing engine, giving K-7 users the ability to 
shoot at a blazing 5.2 frames per second, and super-fast 
shutter speeds of 1/8000th of a second to freeze the fastest 
moving objects you can aim at.

Additionally, the K-7 continues the Pentax trend 
allowing the built-in onboard flash to act as a wireless 
trigger to existing Pentax external flash units. 

Final Thoughts:
While it may not have been the medium format or full 

frame DSLR that some fans were looking for, Pentax has 
outdone themselves with the K-7. The upgraded imaging 
sensor and Prime II processor in the K-7 gets you pro-
level build quality and is close to a full-frame as possible 
at a fraction of the cost. With the same dual dial control 
system all Pentax shooters have come to love, along with 
the inclusion of new technologies, the Pentax K-7 is sure to 
be a hit in the DSLR world.

Editor’s Note: PhotographyBB would like to extend a special 
thanks to Pentax for meeting with us and discussing the new 
K-7 for this edition of the PhotographyBB Online Magazine. 
All images courtesy of Pentax Imaging Company.

This article is Copyright © Dave Seeram. Images courtesy of Pentax Canada Inc. Please contact the author directly with any questions.
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A couple of months ago, I wrote about the 
debate over photographer’s rights in the UK; this 
month I will express my feelings about what is 
going on in my home country, the United States of 
America.  Before I begin, I would like to add that the 
following is only my opinion and nobody else’s.

Sadly, my country, the United States of America, 
is no longer the country it was when I was born.  
When I was young, people could freely speak out 
about their problems and concerns.  A person with 
a camera could go out and would be welcomed 
just about any where, but that has changed.  
Nowadays, a person with a camera is automatically 
though of as being up to no good.

Thomas Jefferson, one of the founding fathers 
of America warned, ‘I’m afraid there will come 
a day when American citizens will be willing to 
surrender their rights that many have fought and 
died for, all for a little false security.  When that day 
comes when Americans are so willing to give their 
rights, so be it.  They do not deserve to have any 
rights.’  Thomas Jefferson was a wise man; he knew 
the nature of the human spirit.  It saddens me, but 
that day Thomas Jefferson was talking about has 
now reached America.    

You may feel this is a stretch, but remember 
your history when in 1933; an unknown Adolph 
Hitler was elected chancellor of Germany.  Germany 
had been defeated in World War One, and had 
just gone through the depression.  Many had lost 
everything they had and unemployment was high, 
so Hitler makes all these promises. “I’m going to 
make everything better, trust me,” and to a large 
degree Hitler did make things better for Germans, 
but at a horrible price.  He told the Germans, “Let 
the government protect you, you do not need 
guns.” Then he took away freedom of speech, and 
at that point it was easy for him to place those he 
felt were anti-German in concentration camps.  But 
if you take a close look at the beginning of Hitler’s 
rule and what is going on in the US today, maybe 
history does repeat it-self, you can not help but see 

the similarities.  

By now you are probably thinking, “Just 
what does all this have to do with photography?”  
Well, just look at how photographers are being 
treated in the US today.  If police are willing to 
arrest journalists, what chance does a citizen 
photographer have?  This is happening far too often 
in the US now.  In on example I can think of in Erie, 
Pennsylvania, a drunk police officer threatened a 
tourist who video taped him and put the video on 
YouTube.  In this particular case, the police even 
questioned the family (in the USA) of the man who 
made the video because the photographer himself 
had already returned to his home in Australia and 
could not be questioned directly. 

It amazes how much trouble you can get 
into for photographing what “they” own.  By 
that I mean taking photos from a public street of 
public buildings that your tax money bought and 
paid for.  For that matter of fact, your tax money 
also pays the salaries of police and government 
officials, so why not photograph them.  As a former 
officer and somebody who has worked in law 
enforcement, I find this new attitude that some 
officers have an embarrassment and it’s even a 
bigger embarrassment that those in charge allow 
this to happen.

But let me say this, not all police are jerks.  I 
watched a YouTube video of a man at an airport 
taking photos of ‘Air Force One.’  He was harassed 
by some airport security guard on some two 
wheel something, the photographer made the 
security guard call the police.  The police came, 
the photographer explained what he was doing 
and the police officer let him take his photos.  So 
when you are out there shooting, remember that 
not all police officers are against photographers. 
As long we as photographers do our best to stay 
informed of the laws and our rights, and do so 
in our professional, positive way, we’ll hope that 
common sense will prevail in this debate over the 
rights of photographers.

PHOTOGRAPHER’S RIGHTS IN AMERICA TODAY:  By Jon  D. Ayres

Photography and The Law
DISCUSSIONS, EDITORIALS, FACTS, AND STORIES CONCERNING THE LEGAL RIGHTS OF PHOTOGRAPHERS 

This article is Copyright © and courtesy of Jon D. Ayres. Please contact the author directly with any questions.
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Port Douglas Get Away
My wife works in the travel industry so we get to 

do a fair amount of traveling. One of our recent trips 
brought us to Port Douglas, Australia. Port Douglas, is 
sandwiched between the Great Barrier Reef and the 
rainforest of Daintree in the Australian province of 
Queensland. Between the rainforest, and the marine 
life of the reef, this area has one of the widest varieties 
of plant and animal life in the world.  

Port Douglas was, until fairly recently, a quiet 
fishing village. This all changed in the late 1980s when 
several large tourist facilities were constructed. Now, 
during peak season, tourists outnumber the locals. 
With its beautiful beach, wonderful people, and wide 

variety of recreational activities, it is a spectacular place 
to head to for a get away vacation. 

We were starting from Boston, so our journey to 
Australia was a long one. Our series of flights took 
nearly 24 hours, and then an hour bus ride from Cairns 
to Port Douglas where finally we checked in to the 
Sheraton Mirage Hotel.  

We booked a couple of tours from the hotel for 
the coming days. With that accomplished, we were 
anxious to get our legs moving after our long journey. 
It was early April, so first we needed to change from 
our winter clothes to something more tropical. We 
checked into our room, changed quickly, and followed 
the path from the hotel to Four Mile beach. 

Photography Around the World 
PHOTOGRAPHIC EXPLORATIONS OF OUR BEAUTIFUL AND MAGNIFICENT PLANET EARTH

PORT DOUGLAS, AUSTRALIA -  By David Martin



Pa
ge

 10

PhotographyBB Online Magazine

Four Mile Beach
On our drive in I noticed that while there were many 

people along the beach, there weren’t any people in the 
water. A sign at the end of the path leading to the beach 
revealed why. It warned that this was stinger season, 
and that swimming could be dangerous. Stingers are 
a dangerous jelly fish, called Box Jellyfish, and stinger 

season runs from November to May. Box Jellyfish have 
powerful venom that attacks the heart and nervous 
system of its victims. Evidently the excruciating pain 
from these stingers can put a swimmer into shock or 
cause heart failure before they can make it to shore. As 
we found out, the only safe place to swim was within a 
small area protected by stinger nets near the town of 
Port Douglas. 
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The walk from the plush surroundings of our 
hotel to Four Mile Beach is a short one. Once on the 
beach, there was very little evidence of civilization. 
To preserve the areas natural beauty, laws restrict the 
height of buildings near the shore, so on our walk we 
saw nothing but beach, ocean, and palm trees. You 
really get the feeling that you are on a remote tropical 
island.

I noticed large areas of patterns on the beach 
formed by tiny balls of sand. I looked closely at one of 
these patterns and saw a very small crab coming out of 

a hole. I read later that they were Ghost Crabs, and there 
are millions of them on the beach. Ghost Crabs feed on 
microscopic bits of nutrients found between grains of 
sand. They strip the off the little bits of nutrients, and 
then form the sand into balls which they toss aside. 
The patterns formed by this process stretch over the 
beach for as far as the eye can see. 

We walked along the beach to the town of Port 
Douglas where we did find swimmers safely swimming 
within the stinger nets. After a quick walk around the 
town we returned to the beach and back to our hotel. 
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Rainforest Habitat Wildlife Sanctuary
The next day, our first full day, we decided to take 

it slow and went for a visit to the Rainforest Habitat 
Wildlife Sanctuary. The sanctuary exhibits a huge variety 
of wildlife separated into three unique environments; 
rainforest, wetlands, and grasslands. It turned out to be 
a great way to spend the day and learn more about the 
area we were visiting.

The sanctuary is wonderfully laid out. Fragile and 
dangerous wildlife are enclosed for protection, but 
other wildlife roam freely within their environment. It 
was great to mingle with the kangaroos, and get up 

close and personal for some great shots of birds from 
the area. You also get close up views of crocodiles. Of 
course, the crocs are enclosed. They aren’t the sort of 
creature you want to come upon unexpectedly.
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Daintree Rain Forest
The following day we went on a tour of the Daintree 

Rain forest, the largest continuous area of rainforest 
on the Australian mainland. We had a fantastic guide 
who was very knowledgeable about the area and had a 
wonderful sense of humor. Because of the canopy that 
covers the rainforest I found it quite dark, even in mid 
day. We were walking along a well traveled path which 
helps protect the impact of tourism on the rainforest. 
It also helps protect the tourist. We passed some spider 
webs that stretched many feet across and in its center 
a spider larger than your hand waiting patiently for 

its next meal! I was glad not to be walking into one of 
those.

Our tour took us to a remote waterfall called 
Dinosaur Falls, a beautiful spot and free of crocodiles 
so it was safe for a swim. Our guide explained how the 
presence of crocodiles is not to be trifled with, and 
described a news story concerning a couple of missing 
tourists. It seems two young men were swimming in a 
creek in the area, and warned by some of the locals that 
swimming there was potentially dangerous due to the 
presence of crocodiles. The two young men ignored 
their warnings. Police investigating the disappearance 
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documented the missing tourists’ encounters with the 
locals. They were never found. 

Our Daintree rainforest tour grew to a close at Cape 
Tribulation. It is at this location where the reefs come 
right to the shore to meet the rainforest. The cape 
was named by British explorer Lt. James Cook in 1770 
after his ship was badly damaged running into this 
reef, and his voyage was delayed for seven weeks. The 
experience prompted him to name the location Cape 
Tribulation “because here began all our Troubles”. 
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Great Barrier Reef
Our next tour took us out to the Great Barrier Reef. 

The Great Barrier Reef is the world’s biggest structure 
made by living organisms, and is so large it can be 
seen from space. It is roughly parallel to the coast of 
Queensland, and stretches for almost 2,000km. The 
huge variety of marine life, and the beauty provided 
by the colors of fish and coral, makes this a prime 
destination for travelers worldwide. It’s the perfect 
place to go snorkeling and explore. Our tour also 
provided access to rides in a glass bottom boat. While 
the conditions aren’t perfect it is still possible to get 

some reasonably good photographs of the reef from 
the boat. 

While swimming in the Great Barrier Reef amid 
the dazzling color and grandeur of the surroundings 
it is still important to remain cautious and mindful of 
potential hazards. In fact it was off the Port Douglas 
coast on September 4th, 2006 that the world famous 
wildlife expert and conservationist Steve Irwin was 
killed by a freak stingray attack while snorkeling.

Kuranda and Barron Gorge
The next day we went on a tour that took us by 

Skyrail Rainforest Cableway over the rainforest to 
Kuranda, and then a return trip on the Kuranda Scenic 
Railway. The skyrail had two stops along the way, 
where we were able to walk along the boardwalks and 
explore the forest. My favorite spot was the Barron Falls 
overlook which provided spectacular views of Barron 
Falls. 

To learn more about the rainforest we visited 
the Rainforest Interpretation Centre. The Centre was 
developed in conjunction with the Commonwealth 
Scientific and Industrial Research Organization (CSIRO), 
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Australia’s premier scientific research organization. The 
Centre offered videos, computers, and displays that 
explained the complex ecosystem of the rainforest. 

We made our return trip on the Kuranda Scenic 
Railway. The railway provided views on the opposite 
side of Barron Gorge, and made several stops so that 
we could get out and photograph some of the more 
spectacular scenery.

On our way back to the hotel from the tour our 
guide told us a story that explains just how much 
wildlife is such a part of living in the area. He lives in 
a small home just a few miles out of Cairns. One day 
he heard his dog barking wildly out by his shed, and 
went out to investigate. As he approached the barking 
suddenly stopped, but he didn’t see his dog. He walked 
up to the shed, looked underneath, and saw his dog 
was half way down the mouth of a 12 foot python! He 
ran to get his wife and, with her help, managed to grab 
the back end of the dog and pull while banging the 
python with a hammer. Eventually he got the dog out, 
bloodied but alive. He and his wife carried the python 
off the property and let it go, then rushed the dog to 
the vet. The dog survived, and the guide now claims it 
is the best snake alarm dog in Australia. 

Final Day

Unfortunately we only had a week to explore Port 
Douglas, but we enjoyed every minute of it. I would 
love to visit again. With its many attractions, beautiful 
beach, and wonderful people, how could you go 
wrong?

This article and all images contained are Copyright © and courtesy of David Martin. Please contact the author directly with any questions.



MORE PORT DOUGLAS PHOTOGRAPHY: By David Martin

This article and all images contained are Copyright © and courtesy of David Martin. Please contact the author directly with any questions.
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Q: Are third party lenses (e.g. Sigma, Tamron, Tokina) 
as good as the equivalent from Canon, Nikon, Pentax, 
Sony,  etc?

The simple answer is that they can be.  Third party lens 
companies often make a range of professional lenses (e.g. 
Sigma’s EX series) which are built to a very high standard 
using top quality glass, excellent weather sealing and 
high speed autofocus motors.  These are often almost as 
good, and in some cases actually better (see box below) 
than the OEM equivalent.  So although a $US 1,000 Canon 
lens might be marginally better than a $US 600 Sigma, the 
Sigma will almost certainly better an equivalent priced 
Canon model.

It is usually only at the very top of the range with 
specialist lenses that third party companies can’t compete 
(usually because the market for such lenses does not make 
it worth their while to produce one in direct competition).  
For example Sigma doesn’t make a lens to compete with 
Canon’s 400mm f/2.8 IS (at $US 6,800).  However the fact 
that Sigma make a 200-500mm f/2.8 which costs $US 
29,000 shows they must have something going for them!

So if you decide to ignore third party lens manufacturers, you just might be throwing money away.

Welcome to our 3rd FAQ column, where we’ll explore some of the common recurring questions 
that many beginners have, but are often too shy to ask. Remember to let Dave or I know if there 
are any questions that you think should be included in future FAQ columns, because for all the 
brave souls who step up and submit a question, there are literally thousands more who sigh in 
relief and benefit from the answers. Let’s get started!

Frequently Asked Questions

LENSES, FILTERS, MANUAL MODE, AND MORE!:  By Colin Bell

A BEGINNER’S GUIDE TO THE MOST FREQUENTLY ASKED PHOTOGRAPHY QUESTIONS

Sigma Beats the Big Boys

Occasionally a third party lens manufacturer comes out with an absolute cracker of a lens and Sigma did 
just that with their 50mm f/1.4 (pictured).  Although it is priced almost the same as the Nikkor 50mm f/1.4G 
and the Canon 50mm f/1.4 (based on current prices at Indorama), it consistently beats the two big names in 
reviews for image quality.  In fact the Canon and Nikkor lenses (which both weigh 290g) feel positively flimsy in 
comparison with the Sigma 520g optic.

With the rise in popularity of wide-telephoto lenses, the 18-200mm lens is increasing in popularity.  Canon 
and Nikon both make one ($595 and $669 respectively) which the Sigma 18-200mm has in its sights.  At $440, it 
should not really have much of a chance – but in a review in the UK’s leading photography magazine, the Sigma 
beat both – the only one to get five stars for image quality – so it wins before you even take into account the 
financial savings.
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Q: Should I use a UV filter on my lens to protect the 
front surface?

Although it will provide some level of protection, 
you should be aware that it can also degrade the 
image quality due to internal reflections in the lens 
(light bouncing off the image sensor back into the lens, 
and then off the filter back onto the image sensor in 
another place).  This can lead to bright blobs of light on 
your photos that just weren’t there in the scene.

For many years I used to have a skylight filter on 
my lens – however for the last few years I’ve removed 
all filters other than ones I put on as I require them.  For 
protection, I would recommend using a lens hood – it 
not only reduces lens flare, but can take the brunt of 
most knocks.  If you really must have a filter on there – 
I’d suggest you buy a professional grade filter and don’t 
expect it to be cheap.  Of course, the benefit is that one 
day it may prevent what is shown in the image.

Q: Why is Live View often so highly recommended 
for macro photography?

The main reason for this is to do with depth-of-
field.  The first thing to understand is that with macro 
photography, the depth-of-field can be incredibly 
shallow (less than 1mm is not uncommon).  Therefore 
accurate focusing is absolutely critical.

With live view, you can usually enlarge the central 
part of the image by about 10 times so you can see 
precisely how accurate your focusing is.  However 
there is another reason and it is to do with a limitation 
of the optical viewfinder system in all DSLRs.

Although a lens might have a maximum aperture 
of f/1.4 or f/2, the viewfinder system has an additional 

aperture which means that the depth-of-field you see in 
the viewfinder is actually closer to what an f/4 aperture 
would give you.  So what might appear in focus in the 
viewfinder could actually be slightly out-of-focus on 
the sensor.  As live-view takes the feed straight from 
the sensor, this issue is not important.

Q: What is the key to sharp images?

There are lots of factors that contribute to a sharp 
image – but here are my top ten:

• Use the sharpest aperture for the lens – this is usually 
about 1 to 2 stops down from the widest aperture.  So 
if you have an 18-55mm f/3.5-5.6 kit lens and you are 
shooting at the 55mm end, set your aperture to f/8 to 
f/11 (assuming your shutter speed is not too slow).

• Invest in good quality lenses.  Kit lenses are build to a 
tight budget, but if you spend more, you’ll find image 
sharpness will generally improve.

• Use prime lenses (not zoom) – this can make a huge 
difference, especially at the budget end of the market.  
The Canon and Nikon 50mm f/1.8 and Pentax 50mm 
f/1.4 are phenomenal lenses for image sharpness, yet 
are the cheapest lenses in the range.

• Use the lowest ISO possible.  High ISO means more 
noise, which generally means the camera will bring in 
greater noise reduction. This obliterates detail and kills 
the sharpness in the image.

• Use a tripod. If shutter speeds are getting a little 
slow, then use a tripod.  If you don’t have one, use your 
camera bag and set the camera on it.

• Pressing the shutter button can cause camera 
shake, therefore use a remote release.  When I am out 
shooting, my infrared remote shutter release is always 
in my pocket and not the camera bag.

• For a landscape, using mirror lockup can remove 
another source of camera vibration.

• Turn image stabilization off.  No that is not a typo.  If 
you don’t need the IS (i.e. your camera is on a tripod), 
then turning it off prevents the camera from potentially 
detecting movement that wasn’t really there.

• Post processing: You can fake a little bit of sharpness 
using tools within your image processing software (such 
as the Unsharp Mask).  In reality, all it does it adjust the 
contrast around edges to give an apparent increase in 
sharpness, but the effect can be quite stunning.

• If you are using manual focus, use live view if available. 

Is this enough to scare you into thinking you need a filter on your lens?
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The image you see through the optical viewfinder has a slightly greater depth-of-field than the image sensor and 
therefore your focusing which might be spot on in the viewfinder, may be slightly off on the image sensor.

Q: I am always hearing these two terms: What is the difference between HDR and Tone Mapping?

To truly represent the high dynamic range of a scene in a photograph, you should be able to store every bit of 
information captured (even if that capture process involves taking many different images at different exposures).  
An 8-bit per channel image (like JPEG) can only store 256 different levels - a 16-bit image can store 65,536 levels 
per channel.  However, a HDR scene can often contain even more, therefore a true HDR image really needs a 32-bit 
per channel image format.  There are dedicated formats for this such as Radiance RGBE (.HDR) but these are not 
common, and you certainly can’t take them to your local Wal-Mart/Tesco to be printed.

In fact, if you look at a true HDR image on the screen it won’t look at all like you expect as a regular consumer 
monitor screen is not capable of handling the sort of dynamic range in the file.

So when you are browsing photo sites such as Flickr, and you see images described as HDR, are they really HDR 
images?  Well the answer is yes and no, depending on your definition.

Yes in that these images do contain the wider dynamic range of the original captured scene contained within 
a single image, but no in that it has been saved as an 8-bit image which is only capable of showing 256 levels per 
colour channel, and therefore does not contain all the original information that was captured.  A lot of information 
has been thrown away to accommodate that wide dynamic range into the limits of an 8-bit format.  Effectively the 
tonal range has been compressed.  What you are looking at is a tone-mapped image.

Tone mapping basically maps one set of colours to another to approximate the appearance of high dynamic 
range images in media with a more limited dynamic range including prints, CRT or LCD monitors. These devices 
have a limited dynamic range which is inadequate to reproduce the full range of light intensities present in natural 
scenes.

If you have a specific question you would like answered, please send them to me or Dave Seeram and we may be able to 
include them in a future issue (anonymously of course). Questions are encouraged, so let’s have them!

The above image has been tone mapped.  In the original scene the whole sky was brighter than any of the lower half of the image. Local adjustment has 
darkened much of the sky and brightened some of the rail track so the single image now contains more of the dynamic range from the original scene

This article and images contained are Copyright © and courtesy of Colin Bell. Please contact the author directly with any questions.
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The Principle

The Rule of Thirds is a general rule of composition 
that suggests we divide our image up mentally into 
horizontal and vertical thirds to try and compose 
things interestingly.  In general, the rule suggests that 
you can make things more interesting by placing the 

subject either on a hotspot or on one of the imaginary 
lines.  There’s a plethora of material on this, so rather 
than go into great detail, will just use a visual to get the 
point across concisely.

The problem regarding composing with a rule 
of thirds grid in mind comes from defining what is 

THE RULE OF THIRDS: By Jason Anderson

Photographic Food for Thought

We’ve all seen the term used, and the approach should not be a novel one to most of us at this 
point. But today, I’d like to take the Rule of Thirds and look at it from two distinct approaches:  
landscape and portrait photography.  The reason is because the rule can be applied in different 
ways and these genres illustrate well how the same rule can be applied completely differently.

PHILOSOPHICAL ISSUES, CONSIDERATIONS, & DISCUSSIONS ON PHOTOGRAPHERS AND DIGITAL PHOTOGRAPHY
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interesting.  Do we place our subject on a hotspot or 
on one of the lines?  It also is a matter of which hotspot 
or line to place your subject on.  Think about it, we 
can put a subject on the lower third or upper third, 
but which looks better?  One person may look at the 
picture and say the upper third looks better, while 
another may say the lower does, and yet another may 
say that the image calls for breaking the Rule of Thirds 
and centering the subject!  Clearly, there are many 
different interpretations.  Today though, we’re focusing 
on the two distinct approaches of using the hotspots 
versus the lines.

The Results

The upshot here is that it seems the hot-spot 
approach works well with portraiture while the linear 
approach seems to work well with landscapes.  If you 
look back in your own image libraries, I bet your favorite 
landscapes have the horizon on one of the horizontal 
“thirds” lines.  If the horizon is on a bottom third, then 
the emphasis is likely on the sky, while if the horizon 
is on an upper third, the emphasis is more focused 
(pardon the pun) on the foreground.  Here are a few 
examples of landscapes that incorporate the Rule of 
Thirds to illustrate what I am talking about…

Can you see the “thirds” lines?  I could do the 
overlays, but think you can probably get the gist.  But 
now, try to visualize the hot spots in these images.  A 
little trickier isn’t it?  I think it’s because hot spots as 
subject points in landscapes are scarcer.  This is not 
to say they do not exist because they do, and there 
is sufficient evidence to support that, but overall a 
landscape image is more about the entire scene. The 
best way to convey that scene is by composing to 
accent the best elements, which are often the lines, 
whether it’s lines of water rippling, lines of trees, or 
lines of mountains and such, the best way to position 
these is with lines rather than hotspots.

Likewise, if you are shooting portraiture, some of 
the best results I’ve seen have been where the subjects 
face (and particularly, the eyes) land on a hotspot.  Take 
a look at these examples here:
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Can you see the hot spots and where their eyes are?  I could do the overlays but again, think you probably get the 
gist here.  Where are the imaginary “thirds” lines though?  Not as easy to imagine here either, and for similar reasons.  
Because it seems as though portraits tend to lend themselves toward what I am calling “hot spot composition”, while 
landscapes seem to tend toward “thirds line composition”.

Rule of Thirds – the History

So, the question we are now presented with is whether the premise holds.  Does history lend support to the idea 
that portraiture works from a hot spot composition and landscapes work from a third linear composition?  There’s 
only one way to find out, and that’s to apply the premise to well-known works from history.  

You could take one of three approaches here – look at a lot of landscape works, look at a lot of portraiture work, 
or a little of both.  For the purposes of this article, and due to time constraints, I chose the third.  I did so by taking 
advantage of the open sourced nature of Wikipedia for some well-known works of art which have survived the test 
of time to see how they measure up under the Rule of Thirds.  The three I picked for the purposes of this essay are 
Picasso’s “Three Musicians, Van Gogh’s “Street Scene in the Montmartre”, and Monet’s “Impression, Sunrise”.  These 
were picked completely at random, primarily because if the premise holds from any random three images or works 
of art, then it will likely hold true for a more exhaustive analysis.  Admittedly, this gives an albeit limited cross-section 
of portrait work and landscape work, but nevertheless, it does suggest that the premise may hold true historically.  
Let’s take a look at each of these:

The first image is from Picasso, from his Cubism work, titled Three Musicians…

A super-imposed Rule of Thirds grid is rather telling.  While this construct is somewhat different, because of the 
style of Cubism, I found it interesting to see the lines that he painted also fell into roughly the same places as those 
of the Rule of Thirds.  And the hot point in the upper left is kind of close to the “face” of one of the musicians.  Does 
the rule of Thirds apply here?  Given the linear composition, my vote is yes, but the hot spot theory is not as well 
established here.  I would propose that it’s due to the era of composition, and that Cubism does not apply well to 
this particular analysis.  Oh well, let’s move on…
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Next up, is Van Gogh, with a painting titled “Street Scene in the Montmartre”:

Here, hot points are very much at play, 
with the people walking down the street, 
coming in at the lower left hot point, and the 
red splash of color on the windmill is very 
close to the upper right point.  The fence 
line also roughly follows the lower third so 
elements of both compositional styles are 
present here.  Does the Rule of Thirds apply 
here?  I’d say yes!  Perhaps the hot spot versus 
linear theory for portrait and landscape isn’t 
as grounded as I thought, but the premise 
of a Rule of Thirds being evident in works of 
art does seem to be gaining ground, from an 
historical perspective.  

Lastly, let’s take a look at one of the more abstract artists in history:  Monet, and one of my favorite works of his, 
“Impression, Sunrise”…

These are but three single instances of works of art that have survived the test of time.  There is so much history 
to art and its creative appeal, but I would venture to guess that much of it has some elements of composition in 
common throughout the ages.  Yet, there will always be exceptions, but that’s when you have to ask yourself, the 
exceptions to the rule usually indicate that there is a rule that applies – the Rule of Thirds.

This article and photographs contained are Copyright © and courtesy of Jason Anderson. Please contact the author directly with any questions.
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Highlights vs Shadows

For the purposes of illustration I have used portraits converted to black and white throughout. This helps 
distinguish highlight, shadow and tone: the basic elements we need to work with to emulate three dimensions in a 
2D image. The light can be dominant as in Nhuc on the left where the shadows define the features or more subtle 
like the image of Dominic (above right). In the portrait of Dominic, lighting is used to highlight the edge of his face, 
the bridge of his nose and the contours of his mouth. 

 First of all we will look at the labels and functions of the lights themselves, then some basic set ups.

PORTRAIT LIGHTING BASICS:  By John Ogden

Portraiture Photography 101
TIPS AND TECHNIQUES FOR STUDIO AND PORTRAITURE PHOTOGRAPHY AND LIGHTING

Jargon Buster: Just like any other specialist topic, photographic lighting is littered with jargon; 
“broad”, “loop”, “kicker” to name a few. In this first of a new series of articles for PhotographyBB 
magazine, I will explain and illustrate some of the main terms used in portrait lighting. This is by 
no means a definitive list, and different photographers have favourite names for their pet lights 
and set ups. But at least it gives us a common starting point!
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Lights and Placement
 

Main Light or “Key” Light:

If you are outdoors, your main light is of 
course the sun, the main source of life giving 
energy. Our brains are hard-wired to find light 
coming from up there, natural and attractive (In 
biological psychology it is widely recognized 
that the human brain has a specific area that is 
strongly activated when presented with correctly 
lit facial features). Daylight throws recognizable 
shadows and helps describe natural form, 
particularly for the human face.

 In the studio your main light (sometimes 
called “key” light) may be a studio flash or a 
continuous light source. Placing this main light 
high in the studio and shining down at about 45 
degrees will provide illumination that simulates 
the position of the sun and results in a pleasing 
portrait.

Changing the position of the key light 
relative to the camera and the subject makes a 
significant difference in the overall result. Even 
small changes can have a dramatic impact. In 
the top image of alterative model “Coventina” 
shown here, the key light is set directly above 
the camera (sometimes described as “on camera 
axis”) and placed high above to shine down at 
about 45 degrees.

In the second image the key light has been 
moved slightly camera right and in the third 
even further to the right.

Notice as the key light moves the shadows 
change making subtle differences in the eyes, 
cheeks and under the chin and the nose. The 
nose shadow is the most prominent and often 
used to classify types of lighting set up (as you 
will see on the next page).

The three images shown here also included 
additional lights to compliment the key light, 
which we will learn more about in future articles. 
For the purposes of this article, we will focus on 
the key light positioning and placement.
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Fill Light

The latitude of digital capture, and previously silver based media, is such that it will rarely record the full range 
of tones presented. A second light used to lighten, or “fill”, the shadow areas helps to compress the range of tones 
across the image. The output of this Fill Light is carefully balanced with the Key Light for the desired effect.

Accent or “Kicker” 

Addition lights are often used to add detail or drama to a portrait. They are referred to by numerous inventive 
names; short accent, angels touch, kicker light, Rim Light etc. They are usually placed behind the subject often 
pointing almost directly towards the camera.

Hair Light 

The Hair Light is accent lighting that emphasizes the hair or helps separate the subject from the background, 
particularly useful for dark hair against a dark background.

 

These two images rely heavily on careful accent lighting. Dan on the left is framed by two equal accent lights 
placed behind him at an equal distance to his left and right. The lights trace the outline of his hat and jacket and help 
highlight his face and facial features.

In the corporate portrait of Mr Sherwyn Singh, Managing Director of Hi-Touch Video-on-Line, I used a single 
accent light behind and to the right which falls on his hair, glasses, facial hair and shoulder to add dimension and 
separate him from the background.
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Basic Lighting Setups

Set ups can be categorized into two main types “broad” and “short”. These two images of Jess show the difference. 

Broad Lighting

In Broad lighting the key light illuminates the side of the subject’s face that is closest to the camera. This can help 
to fill out a slimmer face making it look “broader”. 

Short Lighting

Short lighting is the opposite of broad lighting. Now the side of the face away from the camera is lit by the key 
light producing a slimming effect.

Notice in this example the key light remains in the same place and the model has changed her position relative 
to it. The same effect can of course be achieved by repositioning the light.

Common Variations of Broad Lighting 

Beauty: For fashion and beauty pictures, shadows are minimized so as not to distract from the shade and form 
produced by the make-up artist. The key light is low on camera axis as in the image of Coventina (top left, on the 
following page). Compare the shadows here with the first set at the beginning of this article.

Paramount: When the key light is raised slightly a small butterfly shaped shadow is formed under the nose shown 
perfectly in the picture of Tarla (top right, on the following page). This lighting set up is also referred to as “Butterfly 
Lighting” for this reason. 

 
Loop: Moving the key light away from camera axis throws a shadow from the nose across the lower cheek. You can 
see this clearly in the picture of Dan (bottom left, following page) along with a shadow from the shades! This loop 
shaped shadow gives this pattern its name.

Rembrandt: When the loop shadow meets the far face outline shadow to form a triangle or diamond shaped area of 
light under the eye, as in the final image of Tarla (bottom right, following page) the pattern is called Rembrandt 
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lighting: allegedly named after the 17th century artist and master of portraiture. Rembrandt’s attic studio was 
illuminated by a high skylight and the triangle effect is clearly seen in several of his paintings. Try an image search in 
your favourite search engine for “lady with an ostrich feather fan” for a perfect example.

Try to work out where the light is coming from in your favourite portraits or even when watching your favourite 
TV show. TV and film videographers use the same jargon and techniques. Just try not to frighten your partner when 
you suddenly shout out “Broad, Rembrandt with a high accent kicker!” as you enjoy the latest blockbuster movie, or 
“short twin accent, hairlight and a high Paramount” during an episode of CSI. 

Stay tuned for more on portraiture and lighting in our next issue! For more examples check out the portraits section 
of my portfolio at http://www.csace.co.uk

This article and images contained are Copyright © and courtesy of John Ogden. Please contact the author directly with any questions.

Beauty Paramount

Loop Rembrandt
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Digital Photography 101

SYMMETRY:  By Gareth Glynn Ash

To paraphrase an old photography saying, there are many things to see if you just look around. 
One of the things, or concepts if you will, that surrounds us wherever we look is Symmetry. The 
best way to understand this concept is to think in terms of lines; leading, reflective, circular and a 
host of others. This month we’ll visit the wonderful world of symmetry; that which occurs around 
us all the time, whether natural or man made and also a way that you create your own symmetry 
- something I like to call kaleidoscopic symmetry, with just one image and Photoshop.

Let’s see if we can first try to wrap our minds around this concept. According to Wikipedia we see that:
 
“Symmetry generally conveys two primary meanings. The first is an imprecise sense of harmonious or aesthetically-

pleasing proportionality and balance; such that it reflects beauty or perfection. The second meaning is a precise and well-
defined concept of balance or “patterned self-similarity” that can be demonstrated or proved according to the rules of a 
formal system: by geometry, through physics or otherwise. Although the meanings are distinguishable in some contexts, 
both meanings of “symmetry” are related and discussed in parallel.”
(Wikipedia - http://en.wikipedia.org/wiki/Symmetry)

A COMPREHENSIVE GUIDE TO UNDERSTANDING DIGITAL PHOTOGRAPHY TECHNIQUES  AND CONCEPTS
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Even a cursory glance at this article, which is way 
more technical than we’ll be getting into here, tells 
us that symmetry is all around us; in biology, physics, 
geometry, math, logic, chemistry, architecture and 
even social interactions. We’re literally surrounded by 
symmetry, which is why it can be so vital, so beautiful 
in what we as photographers hold near to our hearts; 
our photos.

There are four main categories of symmetry that 
photographers deal with in their images and with 
our eyes; Reflection, Rotation, Transition and Glide 
Reflection. Let’s take a look at each one separately.

REFLECTION SYMMETRY
“Reflection symmetry […] is symmetry with respect to 
reflection. In 2D there is an axis of symmetry, in 3D a plane 
of symmetry. An object or figure which is indistinguishable 
from its transformed image is called mirror symmetric.”
(http://en.wikipedia.org/wiki/Reflection_symmetry)

In English: A reflection… simply a mirror image. 
Think of it this way: Draw a line through your scene 
(usually vertically, but it can be done horizontally or 
diagonally, too); what you see on one side should be 
equal distance from either side of the axis. In your 
final image, ideally the content on the left and right 
side should be exact, but rarely is this found in the real 
world. See my example on the top right of this page.

Before we move on, note the image in the lower 
left in figure #1 above. Keep this in mind, as it will be 
instrumental when we create our own kaleidoscopic 
image later.

ROTATIONAL SYMMETRY
“Generally speaking, an object with rotational symmetry 
is an object that looks the same after a certain amount of 
rotation. An object may have more than one rotational 
symmetry; for instance, if reflections or turning it over are 
not counted, the triskelion appearing on the Isle of Man’s 
flag (see below) has three rotational symmetries (or “a 
threefold rotational symmetry”).”
(http://en.wikipedia.org/wiki/Reflection_symmetry)

Fig 1. Image Source: http://en.wikipedia.org/wiki/File:Symmetry.png

http://en.wikipedia.org/wiki/File:The_armoured_triskelion_on_the_
flag_of_the_Isle_of_Man.svg
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In English: Something circular that represents 
rotation, as we see here in the image above.

TRANSITIONAL SYMMETRY
“Translational symmetry of an object means that a 
particular translation does not change the object. For a 
given object, the translations for which this applies form 
a group, the symmetry group of the object, or, if the object 
has more kinds of symmetry, a subgroup of the symmetry 
group”
(http://en.wikipedia.org/wiki/Translational_symmetry)

An example of translational symmetry in one 
direction in 2D nr. 1 is:

example example
    example example
       example example
          example example

In English: Uhh … yeah, right. Okay, there’s a lot 
of math involved in this one (which you can see in the 
Wikipedia article if you’re one of those brainy types) 
which I’m not even going to try to wrap my head 
around or explain. Bottom line is this: duplicate objects 

… no flips, axes or rotations (bottom left).

GLIDE REFLECTION SYMMETRY
“A glide reflection symmetry (in 3D: a glide plane symmetry) 
means that a reflection in a line or plane combined with 
a translation along the line / in the plane, results in the 
same object. It implies translational symmetry with twice 
the translation vector. The symmetry group is isomorphic 
with Z.”
(http://en.wikipedia.org/wiki/Symmetry)

In English: Anything that is reflected but is also 
displaced along the axis. “Footprints in the Sand” is 
probably the most recognizable example of this … 
but far be it from me to give you the conventional 
example:

Note how the penguins in each column (just like a 
row of footprints) are mirrored from each other and at 
the same time offset from each other. This is the key to 
glide reflection. Let’s say that, instead of the penguin 
blanket which I used in the example above, I had taken 
a bunch of beer bottles and laid them out as if they 
were “walking.” This wouldn’t have worked because 
of the labels on the bottles … they’re not mirrored! 
Every label on one side would have to be “flipped” to 
reflect (heh!) a mirror image of it’s opposite … just like 
footprints.

As you can see from the examples above, this 
magical world is literally all around us and, what’s more, 
we end up capturing it in our images (consciously 
or not) all the time. Now, I expect you to grab your 
camera, get out there and find and capture some of 
the symmetrical world around you … go on, I’ll wait.

Good … so now that you have your head in the 
right place and can recognize and capture “naturally 
occurring” symmetry, what say we make an attempt at 
creating our own?



Pa
ge

 33

PhotographyBB Online Magazine

Here’s the image I’ll be starting with which, since 
I’m working with a RAW file, I’ve opened in Adobe 
Camera Raw (ACR):

I’ve gone ahead and made some basic adjustments 
first, which I’m not going to show, as I assume you’ll 
want to make these as you see fit, so go ahead and do 
that first.

Now, here’s where the fun, and a certain amount 
of thinking, begins. You’re going to want to crop your 
image in a way so that it will eventually end up looking 
reminiscent of the kaleidoscopes we looked into as 
children. Try to pre-visualize this as you look at your 
image and then grab your crop tool. For this one I’m 
going to use the “normal” crop selection, but for your 
image you might want to go with any of the other aspect 
ratios available. A certain amount of experimentation 
will be involved until you get the hang of what you 
want to accomplish … play around.

The cropping stage is where the pre-visualization 
thing comes in, which I’m going to take a moment to 
try and explain without sounding condescending, so 
bear with me.

If you look at the crop here, what is now (and this is 
key, because it won’t be later) the bottom right corner 
is going to end up being the middle of the finished 
image, so you’re going to want to “pre-visualize” this as 
where the kaleidoscope effect is going to “bloom” or 
“spring forth” from. Hopefully this will become a little 
clearer (if it’s foggy now) as we move along … again, 
bear with me.

So, moving right along; now that I have my crop 
where I think I’m going to like it, I’m going to save this 
file as a TIFF and open it in Photoshop. As shown in this 
3rd image, here’s what we now have:

Generating Symmetry in Photoshop
This is going to be a very fun, creative and easy tutorial to transform a mundane image into something … very 

different, but the one thing you must do is start with a RAW image! You don’t want to lose or destroy your original, 
and chances are that you might have to (or want to) go back and try something different, due to not liking what you 
end up with… Or frankly, it just sucks! So shoot in RAW.

For this tutorial, I’ll be working in Photoshop CS3 but I’m guessing you’ll be able to accomplish this in your 
editing software of choice. If not, you’re S.O.L. I guess! Let’s begin.
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Zoom out (however you prefer to do it) so your image 
covers only around 25% of your palette. We’re going to 
be increasing our canvas size, so this will enable us to 
see what’s happening as we do it.

Go up to the Menu: Select > All…
… which will give you the infamous “marching ants.” 

Go up to the Menu: Edit > Copy …

Go up to the Menu: Select > Deselect …
… which removes the “ants.”

Go up to the Menu: Image > Canvas Size …

Here, change Inches to Percent and enter 200 in the 
Width box and select the middle left box in the Anchor 
so the arrows are pointing to the right.

You’ve now doubled the width of your canvas and 
should have something like this:
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Go up to Edit and choose Paste, which will plop a copy 
of your image onto the middle of the canvas, like this:

Now, go to Edit, Transform and choose Flip Horizontal, 
and you’ll have this:

Note that your copy is now a mirror image of the 
original.

Go to your tool palette and select 
the Move Tool… and grab the 
copy and drag it to the right until 
it “clicks” into place. With your left 
arrow key, “nudge” your copy one 
tap to the left to assure a clean join. 
You’ll now have this …

… and you’ll also have a new layer above your original. 
Go up to the Menu: Layer > Flatten Image.

Now you’ll need to “trim” that little blank space off the 
right side. Go back up to Image > Canvas Size, change 
to Percent again, enter 99.7 in the Width field and click 
the middle left box in the Anchor:

This eliminates that little white strip down the right 
side of your image. 

Things are starting to take shape, huh? Now, you could 
stop there … but why? Let’s go through these basic 
steps one more time with a few simple modifications 
to finish up.
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Go up to the Menu: Select > All... 
Next, Go up to Edit > Copy. 
Then, go up to Select > Deselect. 

Now we’re going to increase our canvas size once 
again; go up to Image and choose Canvas Size, change 
to Percent but this time change the Height to 200 and 
click on the top middle box in the Anchor. 

Go to the Menu: Edit > Paste 
and now you should have this:

Now, once again go up to Edit > Transform but this 
time choose Flip Vertical. Go to your tool palette and 
select the Move Tool, grab this new copy and drag it 
down until it “clicks” into place and with your up arrow 
key, “nudge” this copy one tap for a clean join. 

Again, go up to Layer and choose Flatten Image. Now 
“trim” this image again (Image > Canvas Size; change 
to Percent) except this time enter 99.7 in the Height 
field and click the middle top box in the Anchor and 
… Viola:

Pretty neat, huh? 

You see now why I asked you to keep the image in 
Figure #1 in mind and why I also tried to bring your 
attention to the bottom right hand side of the crop I 
applied? And speaking of that, remember; the “center” 
of your final image does not have to be the bottom 
right of your crop that you create from the original 
image. It can be any of the corners of your crop … it all 
depends on what you see, what your vision of what the 
final image should look like. 

I’m guessing at this point you also understand why I 
stressed starting with a RAW file … you can always go 
back and change the crop around if it doesn’t work out 
the first go around.

At this point you can finish up your image by applying 
any other “tweaks” you’d care to add to make it “pop.” 
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Truth be told, this image was part of a three image bracketed shot, so I went back, re-did everything and gave it the 
ole HDR treatment … here’s what I came up with. This treatment works really well with HDR’s, macros, shots of power 
lines, Jungle Jim’s … almost anything. Your creativity and vision are the only limits.

I hazard a guess that when you start looking for and seeing all that is symmetrical around you — and inside you as 
well — that it can be a very addicting and exciting subject to explore, sure.

This article and all images contained are Copyright © and courtesy of Gareth Glynn Ash. Please contact the author directly with any questions.



SYMMETRY: By Gareth Glynn Ash

This article and all images contained are Copyright © and courtesy of Gareth Glynn Ash. Please contact the author directly with any questions.
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Step 1:
Open up the image that you want to add fireworks to. 
I’m using one of London Bridge at night.
Image credit to: 
Hot Black http://www.sxc.hu/photo/1176628

Step 2: 
Open the fireworks pictures you want to add. In this 
case I’m using three photos, but you might have one 
good shot that you can use.

Image credits to:
Optimind http://www.sxc.hu/photo/1123001
 Itotoro http://www.sxc.hu/photo/1194540
 Itotoro http://www.sxc.hu/photo/1194542

ADDING FIREWORKS IN PHOTOSHOP:  By Jennifer Farley

Adobe Photoshop® Retouching
TECHNIQUES, TIPS, AND TRICKS FOR DIGITAL RETOUCHING OF IMAGES IN PHOTOSHOP®

Getting a good shot of fireworks can be tricky, and getting good fireworks with an interesting 
foreground is even trickier. So here’s a method for combining one or more fireworks photos with 
another night shot and have it blend beautifully.  As with many retouching jobs, we’ll use the 
layer mask to achieve the effect we are looking for. 



Pa
ge

 40

PhotographyBB Online Magazine

Step 3:
Select the Move tool (V) and drag a fireworks image 
onto your photo (in this case, the London Bridge pic). 
You may find the your fireworks image is swamping, so 
you may need to reduce it in size.

Step 4:
Hit Ctrl+T (Win) or Cmd+T (Mac) to use the Free 
Transform tool. A bounding box appears around the 
fireworks image. Hold down the Shift key and click 
and drag one of the corner handles to reduce the scale 
down the image to an appropriate size. (Holding down 
Shift, constrains the proportions of the image.) Hit 
Enter / Return to commit the transformation.

You can see there are two problems here. 
a) The fireworks image is covering part of the bridge
b) The sky is a different colour in each. 

We’ll fix that now.

Step 5:
To get a nice blend of skies, make sure your Fireworks 
layer is selected in the Layers palette. Then on the 
bottom of the layers palette, click on the Layer Effect 
Button and choose Blending Options from the drop 
down menu.
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Step 6:
The Blending Options dialog box opens. At the bottom 
of the box, hold down the Alt / Option key and click 
and drag the triangle to the left. It will look like the 
triangle is split in two. 

As you drag, notice how the fireworks start to blend 
into your background image. Click OK to apply the 
blend.

By holding down the Alt / Option key you get a very 
nice blend here, otherwise it tends to look quite jaggy. 
Try it without holding down Alt to see the difference.

Step 7:
So we still have the problem that part of the firework is 
visible on top of the bridge. This is where a layer mask 
comes to the rescue. 

On the Layers palette, make sure the Fireworks layer is 
still selected. Then click on the Add Layer Mask icon.

Step 8:
Lower the opacity of this layer to about 50% so that 
you can see the bridge behind the fireworks.  Then click 
on the on the Layer Mask thumbnail on the Fireworks 
layer. Choose a small round, soft-tipped brush. Make 
sure that your foreground colour is set to black, then 
start painting. As you paint, you erase the fireworks 
from any foreground elements (ie. the bridge), but 
importantly, you are not damaging either photograph. 
If you make a mistake, switch you foreground colour 
back to white and paint back over the error. 
 
 When you’re finished painting, push the Opacity of the 
Fireworks layer back up to 100%
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Step 9:
I repeated the process twice more with two different 
shots of fireworks to produce this image.

Step 10:
The only thing that’s missing here is a reflection! 
Because I have my fireworks on three separate layers, I 
want to make one extra layer containing a duplicate of 
all three. Select the layers and hit Ctrl + Alt + E or Cmd 
+ Option + E. This shortcut will retain your three layers 
and make one new layer containing the contents of all 
three. 

Select the new duplicate layer and hit Ctrl + T or Cmd 
+ T to bring up Free Transform. Right Click or Ctrl Click 
in the bounding box to bring up the Transform menu. 
Choose Flip Vertical. Drag the duplicate (and now 
upside down) Fireworks layer down onto the water.

Step 11:
Choose Filter > Gaussian Blur. In this case I set the blur to be about 9 pixels.  The final step is to set the blending mode 
of that layer to Colour. And this is how my final image looks.

This article is Copyright © and courtesy of Jennifer Farley. Image credits noted.  Please contact the author directly with any questions.
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PBB: Welcome to PhotographyBB, and thank you for 
joining us today. Why don’t we start by getting to 
know you better - tell us about yourself Chris!

Hello and thanks for the invitation and the privilege 
of sharing my experiences and ideas with everyone. 
PhotographyBB has become quite a phenomenon and 
I find it a bit more diverse than some of the other sites 
I participate in. 

I have lived in Daytona Beach, Florida all my life; 
well its home base anyway. I have always had a bad 
travel bug and a bad case of Wanderlust.

PBB: Tell us about your gear! What equipment do 
you use, and is there any piece of gear that you 
ALWAYS bring with you on a shoot?

Well I am a bit obsessive compulsive, a lot of that 
stems from being a police officer because you had to 
be prepared all the time with extra gear. 

 My truck is packed with lock boxes and dry 
bags. I always have a couple sets of extra dry clothes. 
Raincoats and a jacket called a BugTamer which is 
essential for anyone who shoots outdoors especially in 
the humid, mosquito infested Florida swamps.

PhotographyBB is pleased to welcome one of our long term forum members, Chris Walters (aka SweetLight), to 
the spotlight this month. Chris can be found cruising the forums and sharing some of his brilliant photography 
and art with the members. We welcome Chris to the PhotographyBB Online Magazine.

 THIS MONTH’S SPOTLIGHT INTERVIEW: Chris Walters

Photographer in the Spotlight
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I shoot mostly digital but I always have a film 
camera on me and sometimes it’s just the right thing 
to shoot and sell the client on.  I always have a tripod, 
foam-core for making reflectors and my Holga 120 
camera that I have had for years. Those things are 
infamous and actually liked for always having light 
leaks. Mine did not have any so I dropped it a couple 
times. I took sand paper to the edges of the plastic lens 
that is for the most part tack-sharp. This $20.00 camera 
has created some wonderful images and helped some 
clients move forward into some more cutting edge 
imagery. 

When shooting outdoors a pocketknife and 
flashlight are essential. The flashlight can help you out 
of the woods and comes in handy if you find something 
at night that you want to open the shutter on and paint 
with light.

PBB: How long have you been into photography, and 
can you recall what first got you into photography? 
What is your artistic/photographic background (ie. 
Self-taught, formal training/schooling)?

I really disliked school all the way up through high 
school. I usually felt out of place and disliked the clicks 
and “pretty people” attitude. I always tried to be a 
friend to everyone and I still try to live that way today. 
In high school I wandered into a photo lab by accident 
really, maybe trying to get out of math class but I never 
really left. I spent more than my fair share of time in 
there, most of which should have been spent in math. 
At the time I was not aware of how lucky I was to be 
there and that the two people who were teaching me 
would absolutely shape the course of my life. 

My instructor was a man by the name of Per Hans 
Romnes; a great guy, great motivator and teacher. He 
created great images, took some intensive workshops 
under the great Jerry Uelsman. At the time I was in 
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those classes we had an artist in residence by the name 
of Anna Tomczak who became ultimately a friend but 
more than that, she was creating huge, black and white 
images that she then hand colored. Those images 
were mesmerizing and I did a lot of hand-coloring as 
well. She also taught me alternative processes like 
cyanotypes which one again added a new dimension 
to my work and I was finding my artist roots I think 

thanks to both of them. Anna would enter my life over 
and over throughout my beginning years and still 
does so from time to time today. She later taught me 
Polaroid transfers, which you see in my work a lot. If 
not the real thing, I will emulate it if need be. She is 
one of the few people who get to use one of the few 
Polaroid 20”x24” cameras, one in New York and one in 
Paris. Here images are more incredible every time she 
creates something new. I owe them both a lot. 

I studied photography at the Southeast Center 
for Photographic Studies here in Daytona. It was 
then and is still listed as one of the only community 
college programs that equals or betters lots of 4-year 
programs. They have an incredible museum and are 
blessed with some of the most prestigious speakers 
anyone could hope to see lecture and give workshops. 
I was lucky enough to see photographers like William 
Albert Allard, Ben Fernandez, Mary Ellen Mark, Eli 
Reed, Eddie Adams, and so, so, many more. Not only 
did we get to hear them speak but also they were in 
close contact with us every day of their visits, walking 
the halls with us and mingling. I truly believe the Bob 
Marley line, “In this bright future, we can’t forget our 
past”. I feel bad that it seems to be an overtone of the 
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younger shooters coming up not to pay much attention 
to where our craft has come from and that is ashamed. 
They are missing out on some great bodies of work 
and great resource of knowledge. 

During my studies at the center I shot a lot of 

street type photos as well as portraits. They were 
great but once I found the commercial studio, large 
format cameras and soft boxes, I was hooked. I had an 
instructor by the name of Don Bruening who had been 
in the industry for years as an instructor. He made it a 
point to teach us that there was just one sun and the sky 
and the rest of the world was either a huge reflector or 
scrim. That lesson directed me to not overcomplicating 
the lighting and trying to create beautiful light with 
the least lights. There are plenty of shooters out there 
that can take ten lights and make it look like one. That 
is a talent but one that I don’t have. I enjoy using as 
few lights as possible, maybe even no lights and using 
reflectors and scrims to control them. 

Commercial work became my passion and during 
that time I wandered with my newlywed a bit spending 
time living on the island of Grenada in the West Indies. 
I got to shoot but also indulge my other passions. I 
spent days as a fishing captain and days as a mate to 
our sister boat, sailing and doing day trips. I did some 
work in Jacksonville for a while but ultimately settled 
down in St. Petersburg, Florida, opening a commercial 
studio with a good friend of mine and also getting an 
agent. . We were kids and competing in a pretty large 
market. We were fully on board and began to score 
some major clients around the country including 
Naturally Fresh, a huge company out of Atlanta who 
makes salad dressings and such and also happens to 
own the Hooters chain. We shot a bit of everything 
from fashion to food to huge architecture projects for 
a big builder out of Texas called Brown and Brown. All 
was going well then the first war in Iraq broke out and 
the bottom fell out of the advertising market. We were 
still making it but I took that opportunity to and my 
newlywed and I moved to Athens, Georgia. She went 
to school full time. I took some classes and continued 
my commercial work pitching and landing clients, 
mostly in Atlanta. 
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Some let us just say, life events lead to me leaving 
the photo world for a while. As you can see in my bio 
I became a cop, following in the 40-year career of my 
father. I truly am an adrenaline junky and that certainly 
fed my fire. I saw images of life that no person should 
even have to glimpse at much less stare. Those images 
though came with the smells and sounds of real life. I 
did some high-risk stuff, as well as becoming a hostage 
negotiator. I try to live life for real experiences, as many 
as I can grab. That was a very enlightening and maturing 
path I took. I still have some pretty bad images in my 
mind but I try to work them out in some of my images, 
which is cathartic. I believe that what we are now is 
what we have lived. That job taught me compassion 
and gave me an overall insight on human nature, the 
very good and the very bad. I would not change that. 

New life events had me missing my cameras that 
I had not picked up in 8- years. I found my way out of 
that fire and back into my photo world. When people 
talk to me they find it hard to believe I was in law 
enforcement.

PBB: You have a beautiful and quite diverse gallery 
of photographs on your Flickr gallery. Do you have 
a favorite photographic discipline (ie. Landscapes, 
portraiture, nature...)?

Of course my beginnings were immersed in 
developer, fixer and stop-bath and I miss those days 
but my body does not miss the fumes. I was always 
fascinated with watching the image appear on the 
blank, white paper in the glow of a darkroom light. 

As I developed as a shooter I fell in love with light 
and commercial work, especially with the large format 
cameras. There is a special, almost nostalgic feeling one 
gets while looking through the ground glass of a 4x5 
or 8x10 camera. Learning it is a real challenge getting 
used to standing on your head almost and learning 
that after a while your brain cooperates and helps your 
turn it right side up.

I had my share of portraiture with my fashion 
and Playboy work. Not traditional maybe but I do like 
capturing a person’s personality in a split second. I 
pride myself in the diversity of my work and although 
I only do weddings for close friends and families, I do 
enjoy bridal portraits. 

As far as landscapes and nature go, I am a real 
outdoors person so I have always made those images. 
As I am able to pick and choose my clients more and 
more I have really fallen in love with travel work. I love 
shooting fishing guides out west as well as Bed and 
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Breakfast’s. I always work out a deal with at least one 
guide and one B&B so I can fish for trade and sleep 
for trade. It always works out great. You would be 
surprised how nice people can be, especially out west I 
have found. I also always make sure I have paying jobs 
to do while I am there.

PBB: Your photographs have a unique post-
processing quality to them, which makes them 
really stand out. What post processing software do 
you like to use with your images?

Anything image that you see of mine that looks 
worked is either a hand manipulation or done in 
Photoshop. I spent a lot of time learning Photoshop 
and teaching it. I love the program but I must admit, 
by the time a student gets to me I am learning as much 
from them as they are from me. It’s a nice exchange. It’s 
also nice to see how many different recipes there are for 
cooking an image the same way. When I pitch a client, I 
like to show them diversity and the willingness to take 
chances. I rarely go back to them with only the image 
they asked for. For example, you will see I have been 
doing a lot of smudge type painting in Photoshop. I 

have really sold several clients with that process and 
they have changed entire ad campaigns to use it. 

If it’s not Photoshop then it’s either a cyanotpe 
process, Van Dyke prints or Polaroid transfers. The 
transfers are probably one of my favorite processes 
as they allow me to hand-color and manipulate the 
image right after I pull the film. I also like the fact that 
I can use heavier paper mediums, which allow a more 
aggressive manipulation of the image when needed.

PBB: We’ve had some interesting discussions going 
on at PhotographyBB on post-processing. What are 
your views on post processing an image vs “getting 
it right” in-camera?

This answer goes back to my original baptism into 
photography. I don’t want to get on my soap box here 
but I have a real pet peeve about any photographer 
who comes into the field shooting digital and because 
they can cheaply create a large amount of images that 
are nearly identical so they can choose just the right 
one. I truly believe that those of us who learned film 
development and darkroom work have the upper 
hand in most situations. You may come in shooting 
huge amount of images and picking the one for the 
client to please them but sooner or later it will become 
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very apparent if you have talent or not. There are so 
many rules of lighting, exposure, composition, etc..that 
one learns with film that greatly aid them in the digital 
world. As I said, those tools in the Photoshop toolbox 
are not just made up little icons, they actually mean 
something from the traditional photography world.

PBB: Do you have any particular photographic 
achievement which you are most proud of? What 
are your photographic plans for the future?

I am proud of a lot of my work and had some 
pretty neat experiences along the way. I guess 
one of the things that I am proud of is, while still in 
college I was lucky enough to meet a very well known 
photographer by the name of David Chan who was 
a long time shooter for Playboy. His work is pure and 
clean. He further enhanced my ability to see light and 
opened the doors for a lot of big clients. He taught me 
how to shoot his type of work and all we every carried 
was Our Nikon F3’s, a 85mm lens and a gold reflector. I 
learned to shoot backlit in open shadows, a bit of black 

or white gauze over the lens for softening and a gold 
reflector kickin’ in some sweet, gold light. I learned 
how to shoot women beautifully and love to do so to 
this day. After a few assisting jobs for him, I was hired 
as a stringer for the company, shooting tests for models 
in the southeast. That was all a good time and quite a 
learning experience for a boy at the age of eighteen.

As I grow older I am most proud of my charity 
work. I do it when I can. I do work for an organization 
called Now I Lay Me Down To Sleep, which is a group 
of volunteer photographers who go into hospitals 
with new parents who know their child is terminal. 
They allow us into their lives to photograph a few 
special moments of the family. It’s difficult but very 
rewarding.

PBB: What advice do you have for our readers who 
are either beginners to digital photography, or 
those aspiring to become better photographers?

My advice is also my pet peeve. I really think it’s 



Pa
ge

 50

PhotographyBB Online Magazine

important, for both groups you mentioned, to make 
themselves very aware of the roots of photography. 
Too many kids are coming out of school with digital 
cameras that they can take gigabytes of the same 
image. Hell, anybody can take 25 photos of the same 
subject within a minute or two and odds are you will get 
a decent image once in awhile. Those same people end 
up undercutting bids by real shooters and the client 
finds out in the end that you get what you pay for. This 
has caused a kink in the client/shooter relationship and 
I have seen awesome shooters have to stand back and 
wait for the client to come to their senses. 

I have taught people Photoshop who have no idea that 
just about every one of the tools on the tool bar actually 
represents a real tool that we used in a conventional 
darkroom. There is a group of us that started with film, 
were immersed in it and had to learn digital to keep up. 
I truly feel that the majority of those of us who learned 
like that are bounds ahead of the majority of shooters 
who know nothing but digital. It’s a shame, really. The 

digital world has created “chimps”, those shooters like 
you see in the end zone of the super bowl spending 
more time “chimping” their camera or stopping to look 
at every image to see if they got it right. They would 
have had a hard go at it back when we had to manually 
focus, expose correctly and frame the shot. Honestly, 
looking back, I don’t even know how we did it and don’t 
know if I could again. I am not judging those people but 
I feel your integrity should lead you to treating your art 
with some honor, not just quick-fire shooting. 

Last but not least, make lots of images. When we shot 
film it cost big money to expose so many images, 
especially large format chromes. In today’s world there 
is no excuse for not shooting a lot of work. With that 
said, edit strongly. Fill your book with nothing but the 
best images. Some images may be appropriate for 
stock sales but if you want high-end clients, do high-
end work. If you have fun at it, it will show and people 
will keep bringing you back.

This article and photographs contained are Copyright © and courtesy of Chris Walters. Please contact the author directly with any questions.
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The 15th photography assignment theme was to go out and take a photograph that represented the signs that the spring season 
is upon us. Given the unusually long winter that many of our readers experienced, this task proved to be quite challenging. Our 
members rose to the occasion and came up with some great shots to show that spring is indeed upon us! Here are our top picks.

Photography Assignment Challenge Picks!

Left: Photo by Dean Godden. Top Right: Photo by Greg (GregM). Bottom Left: Photo by Greg (GregM). Bottom Right: Photo by Ian Miller. 
Thank you to all of our photography assignment participants. We look forward to your submissions in our ongoing bi-weekly assignments.

Summertime is always a great time to bring the camera out. Be it a roadtrip, vacation, or just a simple day taking in the sunshine 
at the beach, there’s always something fun to photograph in the summer. It was our members task to take a photo depicting their 
version of “summer fun,” and here are the top pics for this challenge.

PHOTOGRAPHYBB PHOTO ASSIGNMENTS CHALLENGE #17: SUMMER FUN!

Photography Assignment Challenge Picks!

Left: Photo by member Zeus1 (Rik). Top Right: Photo by member “Fryeme”.  Bottom Right: Photo by member “RainbowJunkie”.
Thank you to all of our photography assignment participants. We look forward to your submissions in our ongoing bi-weekly assignments.
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The 15th photography assignment theme was to go out and take a photograph that represented the signs that the spring season 
is upon us. Given the unusually long winter that many of our readers experienced, this task proved to be quite challenging. Our 
members rose to the occasion and came up with some great shots to show that spring is indeed upon us! Here are our top picks.

Photography Assignment Challenge Picks!

For this assignment, we decided that shapes were on the menu, and that particular shape was to be round - the wheel! Members 
were tasked with the assignment of finding interesting shots of wheels, and submitting them to the challenge. As you’ll see from 
the entries both here and in the forums, there were so many spectacular images of wheels, and here are our top picks!

PHOTOGRAPHYBB PHOTO ASSIGNMENTS CHALLENGE #18: WHEELS

Photography Assignment Challenge Picks!

Left: Photo by member “jasbags”. Top Right: Photo by member “doxyfoto”.  Middle Right: Photo by member “Dean”
Bottom Right: Photo by member “Crankypants”.
Thank you to all of our photography assignment participants. We look forward to your submissions in our ongoing bi-weekly assignments.
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PhotographyBB flickr Group Member Photos
The PhotographyBB Gallery group on flickr® is the latest place for flickr® members to participate in PhotographyBB 
Assignments. Each month, in addition to choosing our top photos from the PhotographyBB Forum submissions, we’ll also 
be selecting some images from the talented members of our flickr® group to showcase their photography. Click on the links 
under each photo to view the flickr® gallery of the photographer who submitted the photo.

Best of May Photography:

Bottom Left: Chinese Arch Promontory Summit - sumoetx
http://www.flickr.com/photos/27963332@N06/

Top: “Wheels” - justbkos
http://www.flickr.com/photos/justbkos/

Bottom Right: “Wheels” - Sue90ca
http://www.flickr.com/photos/sue90ca/
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Do You Have a 
Great Idea for 

a Photography 
Article?

We are looking for 
talented individuals 
who would like to 
expand their portfolios 
by volunteering to 
contribute articles to 
this e-magazine! If you 
are interested, we’d 
love to hear from you.

Topics of Interest are:

- Photography Techniques
- Photography on Location
- Photoshop Tutorials
- Hardware / Software Reviews
- Camera Equipment
- Member Spotlight
- Plus we’re open to new ideas!

To become either a regular 
contributing author, or even 
just for a one-time article, 
please email us at: 

magazine@photographybb.com

Introduce yourself, share your 
idea, and maybe we’ll see you 
in next month’s issue!

Step into the Spotlight!
Would you like to be featured in the PhotographyBB 
Online Spotlight on Member section? If so, please let 
us know at: magazine@photographybb.com

We’ll feature your photos, a small biography and write-
up about you, as well as links to your web gallery or 
photography related business. We all love photography 
and image editing, so let’s get to know each other!

Been Around the World?
We are looking for talented writers who would like 
to share their experiences in visiting far away places, 
or even your home town for that matter. In our 
Photography Around the World column, we take our 
readers on a photographic journey, and we would like 
you to be our tour guide.

If you would like to share your story and photography 
of a city you have visited, please contact us and share 
your idea with our team. We’d love to hear from you!

RSS Updates Available:
There have been some requests for email notifications  
of upcoming issues of the PhotographyBB Magazine 
Online. You can receive updates on the magazine as 
well as our blog postings through our RSS feed which 
can either be aggregated to your feed reader, or 
emailed to your email address. Any of our readers who 
are interested can subscribe here:
http://feeds2.feedburner.com/photographybb

Discounts for Readers:
For those of you who are interested in getting into HDR 
photography, there simply is no better HDR software 
then HDRsoft’s Photomatix Pro, available as a stand 
alone software and as a Photoshop Plugin. Visit:
http://www.photographybb.com/hdr/
and use the coupon code: photographybb.com 
for a special discount. Also, check out the Shop 
PhotographyBB site for links to some great deals on 
cameras and accessories. Best deals on the web!

Thank you for reading the PhotographyBB Online 
Magazine. We hope  you enjoyed it, and we’d love to 
see you again next month. If you have any questions or 
comments for us regarding this magazine, please feel 
free to email us at: magazine@photographybb.com


